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• Quick Start
If you don't like to read documentation, please quickly read this section for a brief 
description of how to use Right On Time.  This information is covered in detail in 
the sections which follow.  Registration information is at the bottom of this 
document.

If you have the demo version of Right On Time, you may only add up to 5 events.
"Demo Version" is displayed when printing as well.  Otherwise, it is fully functional. 
You will be given the password to unlock the full version of Right On Time as soon
as your shareware fee is received.

The file "Events" will be read automatically when ROT starts up.  This file must be 
in the same folder as the application.  The first time you start ROT, this file will be 
created automatically (you never have to "save", as events are immediately saved 
each time you create, edit, or delete them).

Archived events are stored in the file "Old Events".  If you have a file named 
"Sounds" (in the same folder) which contains "snd " resources, these sounds will be
added to the list of sounds which can be played when an event comes due (along 
with sounds in your System file).

Each Events file contains its own list of categories which you may edit as you like.



• Introduction
Right On Time is a versatile application which provides To-Do List, Calendar, and 
Reminder features.  You can set up one-time or repeating reminders, and Right On
Time will notify you when the reminders are due.  You can also create to-do items, 
which are like reminders but have no specific due date.  You can organize your 
reminders and to-do items by category, and play sounds when reminders are due.

You can use Right On Time to remind you when bills are due, when birthdays or 
anniversaries are coming up, or other important dates.  With the archiving feature, 
you can also keep a history of significant events.  The perpetual calendar built in to
Right On Time can show you any month of any year (with certain limits).

Currently, two types of views are supported for viewing the events you create: a 
List View and a Monthly Calendar.  The List view is well suited for viewing to-do 
items, but you can view reminders as well.  A menubar clock option is available as 
well.

Right On Time is AppleEvent-aware, and supports the four required AppleEvents. 
Also, a custom AppleEvent is supported which allows you to add reminders from 
another application.

• Installation
Unlike other similar packages, Right On Time is just an application, and does not 
include a system extension.  This gives you more control over how much memory 
is used, and eliminates the possibility of system extension conflicts.  You can start 
up and quit Right On Time any time you want, and no system restart is 
necessary.  Installation is easy: just copy Right On Time to any location you 
prefer.  Three special files, "Events", "Old Events", and "Sounds" must be located in
the same folder as the application.  Your main events file is called "Events",  and 
archived events are placed in the file named "Old Events".  The special "Sounds" 
file must be present if you want to add your own sound effects (you can also use 
the sounds that are inside your System suitcase).  This file contains standard "snd 
" resources.

Right On Time should work on all Macintoshes running at least System 6.  Since 
there are lots of possible configurations and I haven't personally tested them all, 
just let me know if Right On Time doesn't work correctly on your mac and I will 
make the necessary adjustments.

You will probably want to place an alias to Right On Time in your Startup Items 
folder (within your System Folder) so that you can see reminders when you start 
your computer.  DO NOT place the actual application in the Startup Items folder, 
just an alias.  If you leave Right On Time running in the background, you will be 
reminded of events throughout the day.



The file "Events" is the default file which will be read when you start up Right On 
Time in the future, although you may create and read other events files by using 
the File menu.  Only one events file may be "active" at a time.

• Registering Your Software
If you have a demo version of Right On Time, you can transform it into a full 
working version by first sending me the shareware payment (see end of this 
document) and telling me the version number of your copy.  I will then send you a 
password.  In the About Box, there is a button called "Register".  Clicking this 
button changes the software back and forth between the demo version and the full
working version.  To switch to the full working version you must enter your name 
and the serial number (both required), and an optional company name.

Each time you move Right On Time to a different disk and try to run it, you must 
re-enter the registration information.  If you do not remember the correct serial 
number at that time, you can always switch to demo mode.  The demo version 
limits the number of new events that you can create, but it can read in a file with 
an unlimited number of events.

Remember, if you click "Register" while not in demo mode, you will immediately go
to demo mode, and you will have to re-enter the registration information to return 
to the full working version.

• Creating and Editing Events
You must open either the List window or the Monthly Calendar window before you 
can create events.  You can use the Edit menu to create the event, or use a 
shortcut.  You can double-click on a day in the Monthly View to create a new event 
for that day, or click the New Event button in the List window.

You can double-click an existing event in the Monthly Calendar or List window to 
edit that particular event.  To delete an event, select it in the List window and 
choose "Delete Event" from the Edit menu, press the DELETE key, or click the 
Delete Event button (the trash can).  If you choose "Archive Event", the event will 
be removed from the current file and placed in the file called "Old Events".

In the Edit Event window, you can enter several options, most of which are self-
explanatory.  You can type in the date and time, or you can select a date by 
clicking the "Select Date" button (it looks like a small calendar).  Likewise, you can 
enter the time using the "Select Time" button (it looks like a small clock).  You can 
make repeating events, and choose a sound to be played when the event becomes
due.  When an event becomes due, you can specify that it stay in the list, be 
automatically deleted, or be automatically archived.

There is never a need to "save your work", since events are immediately saved to 



disk when you create or change them.

• Importing Events
You can import the events from another Right On Time Events file by choosing 
"Import Events".  Only events with different names (summary) will be added to the 
current Events file.  You should double-check the assigned categories after 
importing events.

• The List window
The List view shows you a list of events for the time period you select.  Only 32K of
information will fit into this list, although it is possible to have even more events 
stored internally.  You can select events and edit, archive, or delete them from this 
window.  Past due events are marked with a bullet ("•").  You can copy selected 
events and paste them into other applications (TAB's are inserted between 
columns).

You may select and event and choose "Edit Event", or just double-click the event to
change it.  The "Delete Event" menu item, the trash can button, or the DELETE key 
will delete an event.  If you choose "Archive Event", the event will be removed 
from the current file and placed in a file called "Old Events".  You may also click the
New Event button (it looks like a hand with a ribbon around a finger) to create a 
new event.

Monaco 9-point font is used for the To-Do list.  If you don't have this font installed 
in your system, the list will not appear formatted correctly.

• Monthly Calendar
The Monthly Calendar is a perpetual calendar which also marks the days on which 



events occur.  When you first open this window, the current date will be hilited, as 
well as listed below the calendar.  You can always click on the current date listed 
below to change the calendar back to the current month.

If you have repeating events, you may opt to see ALL occurences or just the NEXT 
occurence.  You can choose the option you prefer by selecting the "Misc Prefs" 
menu item.  Projecting a repeating event far into the future (like years) can cause a
small delay in updating the calendar.

You can double-click on a date to create a new event on that date.  If you click right
on the text of an existing event, then you can edit that existing event.

The font size of the calendar automatically changes as you change the size of the 
Monthly view window.  At the smallest size, Geneva 7-point font is used for the 
dates.  Since this is not a standard bitmapped font size contained in most systems,
your calendar will not look good at this size unless you have TrueType fonts 
installed in your system.  If you are not using system 7, you can install Geneva 7-
point yourself with the Font/DA Mover.  If you make the window large enough, the 
summary of events will be displayed within each day's box.



• When Events Become Due
When an event becomes due and Right On Time is running, several different 
things can happen.  If Right On Time is in the background, the Notification 
Manager (an operating system feature) is used to notify the user.  Depending on 
how your preferences are set, either a dialog box will appear or the menu bar will 
start flashing.  If the event is really just a warning, then the menu will blink until 
you bring Right On Time to the front.  In either case, a sound will be played 
immediately if you chose one for that event, and a dialog box is displayed once 
Right On Time is brought to the front (the dialog box which is displayed when 
Right On Time is already in the front is a bit more colorful).

When a warning is given and you bring Right On Time to the front, you may 
choose to have the warning played again at a later time.  Note that if you quit 
Right On Time before the warning becomes due, the warning will NOT be given.  
Likewise, warnings which become due before you start Right On Time are not 
given.

If you start Right On Time and some events have become due since the last time 
you quit the application, you will be notified of the past events (unless they are 
more than 1 week old).  You can also look at the List view and see the past-due 
events marked with a bullet ("•").

Past due events usually stay around until you explicitly delete them.  In the case of
repeating events, a new event is automatically created for the next repeating time,
but the old event is not necessarily deleted (the old event is no longer a repeating 
one, but the new one is). When you create an event, you can specify that it be 
automatically archived or deleted when it becomes due.

• Categories
Using the "Categories Setup" menu item, you can customize the list of categories.  
This custom list is stored with the currently open events file.  Remember that each 
events file has its own categories list associated with it.

Each category has a set of default settings associated with it.  You can customize 
these settings as well.  When creating or editing an event, the default settings will 
be automatically set when you change categories.  Of course, you can always 
override the default settings for any particular event.

You can specify the "default" category, which is the category which new events are
automatically set to when first created.

• Menubar Clock
Using the "Misc Prefs" menu item, you can choose to display the current time in 



the menubar, even when Right On Time is in the background.  When you move 
your mouse pointer over the time, the date will be displayed.  In the "Misc Prefs" 
dialog, you can specify how far from the right side to display the clock.

Since Right On Time is an application, and does not patch the operating system 
in any way, the menubar clock cannot always be updated instantly.  In particular, 
when you are running several appliations, it may take a moment longer to display 
the date when you point to the menubar clock.

• AppleEvents Support (programmers only)
Right On Time supports the four required AppleEvents (oapp, odoc, pdoc, quit), 
as well as 1 custom AppleEvent which may be used by other applications to add 
events.  This custom AppleEvent is type "ROT " and id "ADDE".  This AppleEvent 
should contain 2 descriptors: "time" and "name".  The "time" parameter is of type 
long integer, and is the time and date (in seconds, standard mac format) of the 
event.  The "name" parameter is a Pascal-style string of up to 31 characters which 
is the summary name of the event.  These are the only two parameters you may 
send right now; other information will be filled in with default values.

If you would like to take advantage of this AppleEvent support, but would like more
features supported, just contact me and we can discuss your specific needs.

• Virus Checking
Right On Time checks itself when it starts up for the presence of a virus infection.
If critical sections of Right On Time are modified, then a warning message will be 
displayed to this effect.  You can still run the application, though.

• Hot Key
You may press and hold down the OPTION and R keys simultaneously to bring 
Right On Time to the front.  When several applications are running, you may have
to hold down the keys a second or two.

• Shareware Fees
You may freely distribute the demo version of Right On Time.  This version is 
limited to 5 records.  The full version is shareware.  If you send me your 
registration fee (see below), I will send you the password to unlock the full version 
and you will become a registered user.  Each version has its own password.

By becoming a registered user, you will be getting a good value and help to ensure
that people like me keep producing shareware products.  I keep all registered users
informed about new versions, and provide additional support.



Registration fees are as follows:
$15 I will mail or email the password to you
$17 I will mail you the latest version on a disk

Additional Copies:
$8     Next 10 copies (each).  Ask for larger quantity pricing.

MasterCard, Visa:
Add $1 to total

Non-U.S. Customers:
Normally, I can only accept funds in U.S. dollars, but I also accept credit cards for 
your convenience.  If you don't have a U.S. bank account or a credit card, try an 
international postal money order or something similar.  If you still can't find an 
inexpensive means of paying, contact me about an alternate form of payment.

Canadian customers: if your bank does not charge to convert Canadian dollars to 
U.S. dollars, then you may write me a check in Canadian dollars.  My bank will then
contact your bank to do the conversion.  If you write me a check in Canadian 
dollars, please write it for the appropriate amount based on the current exchange 
rate, and make sure that your bank will not charge me to do the conversion.

For fastest service, email me your credit card info and I will email you the serial 
number right away.  Or, if you prefer, phone in your credit card info.

Flat fee site licenses and larger multiple-user licenses are available at greater 
discounts, and are handled on a case-by-case basis.  I require 1 registered copy for
each user, or each computer, whichever is fewest.

You must tell me which version of Right On Time you have, so that I can 
send you the correct password.  Also, this will tell me if you have the latest 
version or not.  When registering, please include your email address for promptest 
service.  Also, I would like to know where you found Right On Time.  I will usually 
respond within 1 to 2 days from the day I receive your payment, so if you don't 
hear from me very soon, you should try again (I have had more than one message 
get lost).

I expect to continually improve this application, and I appreciate any feedback I 
get.  I have a list of planned new features and improvements, and your input will 
affect the priorities of those features.  Send me your cooments!

John Covele, Software Visions
22027 McClellan Rd
Cupertino, CA 95014

AOL: Keymaster5
Internet: Keymaster5@aol.com
CompuServe: 70571,261 (not checked as often)



Telephone support is provided for placing credit card orders, or for questions from 
registered users who have purchased more than one copy.  Otherwise, please try 
to contact me via email.

(408) 446-5855

-----------------------------------------------------
                  Right On Time Registration Form

Name:

Address:

Version of Right On Time that you have (important!):

Email Address:

Where did you find Right On Time?


